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Advantages of Registering
This product is shareware.    This means that this is a fully functional Random Dot Stereogram 
generator, capable of generating RDS images in Black & White, Random Colors, or in Customized 
color schemes specified by the user.    The software will generate images up to 320x200 pixels, with 
two levels of "depth" (the base level and one other level).    Note that this Help file, as well as the 
POPOUT-PRO main menu, have been designed for the non-shareware version of the software.
After receiving your registration, we will send you the non-shareware version of POPOUT-PRO, 
which has the following additional capabilities:
n There are no limitations placed on Source and Destination image sizes in the non-shareware 

version.    Background Images may be as large as 64K pixels.
n The non-shareware version will generate up to 256 levels of depth.
n The non-shareware version of the software is capable of generating Dual-Image stereogram 

images, where a Background Image supplied by the user is distorted to create the hidden image.
n Both Divergent (relaxed eyes) and Convergent (crossed eyes) stereograms can be created with 

the non-shareware version.
n A low pass filter can be enabled to help remove unwanted "sprinkles" from ray traces Targa 

Source images.
n A Depth Factor parameter allows the amount of depth in the stereogram to be controlled by the 

user.
n A Pixel Density parameter allows the user to specify the sparsity of dots in Black & White and 

Custom Color RDS images.
n A Pixels/Inch parameter allows the user to target a specific resolution for the final image, allowing

the software to minimize distortion in the depth dimension.
n An option which works in conjunction with the Pixels/Inch parameter and Depth Factor parameter

to generate the desired quality of image is included, allowing the user to maximize either the 
amount of depth impressed into the image, or maximize the depth linearity (quality) of the image.

n The registered version will optionally create "Guide Dots" on the stereogram image to aid some 
users in viewing.



Installation
Installation of POPOUT-PRO is easy.    Since this shareware is being distributed through a number of
different channels, installation may be different for different users.    

Look for a file called INSTALL.EXE or SETUP.EXE on the POPOUT-PRO diskette.    If it exists (and it
should), then simply click on the "File" pulldown in the Program Manager window, then click on 
"Run".    For "Command", type in "A:\INSTALL.EXE"

Substitute another drive letter for your floppy if yours is not drive "A:".

The POPOUT-PRO Install utility will copy all of the necessary files to your hard drive, then create a 
program group and program items for POPOUT-PRO.



Introduction
POPOUT-PRO generates Stereogram images from drawings that you create.    POPOUT-PRO is 
capable of generating Random Dot Stereograms (RDS), as well as a type of stereogram which uses 
a second image as a tiled background.    At first glance, the images that POPOUT-PRO generates 
appear to be either a series of seemingly random dots, or else a repeating and slightly distorted 
pattern or image.    When viewed properly, however, a "hidden" three dimensional image will "POP 
OUT" of the stereogram!
POPOUT-PRO was designed to be used in two different settings.    In one, the user manually draws 
an image using Paintbrush or some similar drawing tool.    In this setting, POPOUT-PRO is capable 
of generating stereograms with up to 16 levels of depth.    While some very nice stereograms can be 
generated in this manner, manually creating POPOUT-PRO input drawings with much more than 16 
or so levels becomes too difficult for the user.    In the second setting, the user creates the input 
drawing by way of one of the popular ray tracing packages available, such as POLYRAY.    With these
kinds of images as input, POPOUT-PRO is able to create stereograms with as many as 256 levels of
depth.    Once the number of levels in the stereogram increases beyond 30 or 40, the eye tends to 
"blend" these levels to produce the illusion of actual three dimensional surfaces.
POPOUT-PRO does not know or care how these source drawings are created.    It is capable of 
reading 16-color BMP formatted images (which can be created using Paintbrush), as well as Type 1, 
2, and 3 Targa formatted images (which can be created using popular ray tracing software).    16-
color BMP drawings will create stereograms with up to 16 levels of depth, while the Targa formats will
support up to 256 levels of depth.
POPOUT-PRO can create four different types of output stereogram.    The output image can be either
a Black & White RDS,    an RDS with 16 randomly chosen colors, an RDS with a color scheme 
defined by the user, or a stereogram consisting of a repeating pattern or image defined by the user.



Creating a Stereogram
The following are the main steps you will follow in creating a stereogram image:
Create a Drawing
Generate the Stereogram
View and Print the Stereogram
Configuration/Preferences
Options



Create a Drawing
The first step in generating a stereogram image is to design the image that you want to be hidden 
within the stereogram.    This is the most time-consuming part of the process.
POPOUT-PRO has been designed to accept depth-containing files (called Source Files) that have 
been manually created, or files that have been created by some ray tracing program.    POPOUT-
PRO will accept 16-color BMP files (which are easily created using Paintbrush), as well as Type 1, 2 
or 3 Targa files (which most ray tracing software is capable of generating).
We've designed POPOUT-PRO to be used easily in conjunction with Microsoft Paintbrush, which 
most users are familiar with. If you've never used Paintbrush, you may want to spend some time 
getting familiar with it.    If you prefer another drawing tool, you may certainly use it. POPOUT-PRO's 
only requirement is that your drawing be in 16-color BMP format, and that the colors are those 
defined in the Paintbrush palette file POPOUT.PAL..    For purposes of this document, we will assume
that you are using Paintbrush to create your manually drawn Source File images.    We also assume 
that you have access to some ray tracing software such as POLYRAY that is capable of generating 
depth-containing Targa format files.    This is not an absolute requirement for generating stereograms,
but does allow you to create up to 256 levels in your stereograms, whereas the 16-color BMP Source
File will create at most 16 levels of depth.

The topics listed below are geared toward the manual creation of your own Source File drawings 
using Paintbrush, and saving the drawing as a 16-color BMP file.    For creating TGA format Source 
Files, we suggest getting ahold POLYRAY ray tracing software.    This is an excellent ray tracing 
program, and we ask that you support the author by registering your copy of his software.    This 
package is capable of creating Targa files which can be accepted by the PLY2POP utility and 
converted into a Type 3 Targa file which can be read as a POPOUT-PRO Source File.    The only 
limitation is that the ray tracing software must be capable of storing your traced image in either Type 
1, 2 or 3 Targa formats, and impressing depth information into the image either as an unsigned 
integer on the Red channel, or as a signed (and offset by 128) value on the Red and Green channels
(as POLYRAY supports with the '-p z' switch).    You can read more about this in the PLY2POP.TXT 
file.
We recommend that you create your manually-generating drawing by following the steps shown 
below:
Redefine the Paintbrush Palette
Initialize the Paintbrush Canvas
Create your Drawing
Save your Drawing

Warning!
Some new users of POPOUT-PRO invariably try to convert a scanned photograph to a stereogram.   
You should be aware that THIS WILL NOT WORK!    This is not a fault of POPOUT-PRO.    A scanned
photograph contains NO depth information encoded within it.    Colors or greyshades produced by a 
scan are NOT the same thing as depth information.    POPOUT-PRO (or any other stereogram 
generator) has no way of determining relative depth in the image.    POPOUT-PRO Source File 
images must either be created manually (using Paintbrush), or automatically by using some ray trace
software that is capable of impressing depth information into the Source File image.



Redefine the Paintbrush Palette
Your distribution diskette contains a Paintbrush Palette definition file called POPOUT.PAL.    We 
suggest that you redefine the palette using this file.
When you start Paintbrush, you may have noticed that the default Paintbrush palette consists of 28 
colors.    Since Paintbrush can only save 16 of these uniquely (we don't know why), we've limited 
POPOUT-PRO to accepting drawings which are in a 16-color format.    This means that in creating 
your drawing, you will use at a maximum only 16 colors from the Paintbrush palette.
Click on the Paintbrush "Options" pulldown, then click on "Get Colors...".    Select the file 
POPOUT.PAL from your POPOUT-PRO directory.    This file will redefine the Paintbrush palette such 
that all but 16 colors will be "blacked out".    Furthermore, the remaining 16 colors will be rearranged 
in such a way as to make it easier for you to remember which color will map to which level in the 
stereogram.



Initialize the Paintbrush Canvas
Only the left-most 16 colors of the Paintbrush palette (8 on top and 8 on the bottom) will be used in 
creating your drawing.    If you've redefined the palette with POPOUT.PAL, these colors are the only 
ones remaining.
Before starting your drawing, you should clear the canvas to Black.    If you've used POPOUT.PAL, 
this will be done for you.
Before clearing the canvas, you might want to decide on an image size.    Click on "Options", then 
"Image Attributes".    Click on the "pels" (meaning pixels) "radio" button.    Enter the "Width" and 
"Height" of your image.    We suggest starting with something small, like 320 Width by 200 Height.
Once you've chosen the size of your drawing, you're ready to clear the canvas. Click on the top-left 
color of the palette with the RIGHT mouse button.    Click on the "File" pulldown, then click on "New".

Hint:
Later, you may want to experiment with clearing the canvas to a different color.    You can get some 
interesting "Push In" effects (rather than POP OUT) in your stereograms.



Create your Drawing
This topic refers to the creation of a Source File drawing using Paintbrush to manually draw your 
Source File.
Creating your drawing is the most time consuming part of generating a stereogram image.    This is 
where you will actually draw the image that you want POPOUT-PRO to hide within your stereogram.
Using all of the normal Paintbrush tools, go ahead and create your drawing.    The important thing to 
remember is that the colors you choose will be interpreted by POPOUT-PRO as "levels".    Of the 16 
left-most colors, the color on the top left (Black if you've used POPOUT.PAL) will be interpreted as 
the level furthest from the viewer.    The next color (Dark Red if you've used POPOUT.PAL) is closer 
to the viewer.    This continues on until the bottom-right color (White if you've used POPOUT.PAL) is 
the closest level to the viewer.

Important!
Do not confuse these colors with the colors of your stereogram.    The color of your stereogram has 
nothing to do with the colors you use to create your drawing.    The colors that you use here is simply 
a way for you to put depth information into your drawing.

Hint:
If this is your first time, you may want to use a drawing that we've included on your diskette, rather 
than creating one of your own.    Click on "File", then click on "Open".    Select the file EXAMPI1.BMP 
from your POPOUT-PRO directory.    This is a good example of a 16-color drawing.

Another Hint:
When you're creating your drawing, try not to have less than 3 or 4 pixels of the same color (level) in 
one horizontal row.    For example, don't draw a vertical line that is only 1 pixel wide.    Because of the
way the illusion works, something like this will be very hard to see in the stereogram.



Save your Drawing
Once you're finished creating your drawing using Paintbrush, you will need to save it to disk in order 
for POPOUT-PRO to read it.    Your drawing (which POPOUT-PRO calls a Source File) must be in a 
16-color BMP format.
To save the drawing, click on the "File" pulldown, then click on "Save As...".    In the "Save File as 
Type" window, select "16 Color bitmap".    Here, you will need to choose a filename, for example, 
EXAMPI.BMP.

Hint:
We prefer to save Source File images in a separate directory from Destination and Background 
images.    This helps to keep things less cluttered.    Note that you can specify default directories in 
the POPOUT-PRO Preferences menu.



Generate the Stereogram
Once you've either manually created your Source File drawing using Paintbrush, or obtained it as 
output from a ray tracing program, you're ready to start POPOUT-PRO.
In the POPOUT-PRO Main Menu, you will specify the Source File drawing and specify a filename for 
POPOUT-PRO to save the stereogram, called the Destination File.    After filling in a number of 
optional parameters, you will be ready to generate your stereogram.    The following topics provide a 
description of all of the controls in the POPOUT-PRO Main Menu.
Source File
Destination File
Background File
Output Style
Color File
Create Color
Pattern Width
Pixel Density
Depth Factor
Pixels / Inch
Generate and Exit
Options



Source File
The Source File is the filename of the image that contains the depth information for the stereogram 
POPOUT-PRO will create.    If you've manually created this file using Paintbrush, you must save it as 
a 16-color BMP image (note that Paintbrush defaults to 256-color; you will need to select 16-color).    
The Source File may also be a Type 1, 2, or 3 Targa file.    If the file is Type 1 or Type 2 Targa, depth 
information is expected to be an unsigned integer value in the Red channel.    If the Source File is a 
Type 3 (Greyscale) Targa, depth is interpreted as the intensity of the grey value.    Depth encoded 
images produced by programs like POLYRAY are not quite compatible with this format.    The DOS 
utility PLY2POP will convert a POLYRAY depth encoded Type 2 Targa file to a Type 3 Targa file with 
depth encoded as intensity, which is a suitable Source File for POPOUT-PRO.    The Source File is 
the main source of information for POPOUT-PRO when creating a stereogram, as it contains the 
image that POPOUT-PRO will hide within the stereogram.
In the POPOUT-PRO Main Menu, click on the Source File button, and select the filename of the 
drawing that you created.



Destination File
The Destination File is the file which is your stereogram.    POPOUT-PRO-PRO will create this file.    
The purpose of the Destination File button in the POPOUT-PRO Main Menu is for you to specify the 
filename.
POPOUT-PRO saves stereograms in either BMP or TGA format.    For the RDS Output Styles, the 
Destination File type (BMP or TGA) must be the same as the Source File.    For the Dual-Image 
Output Style, the Destination File type must be the same as the Background File type.

Hint:
We prefer to store Destination Files in a directory different from where Source Files are stored.    This
helps to keep things organized.    Note that you can easily specify a default directory for your image 
files in the POPOUT-PRO Preferences menu.



Background File
The Background File is only used when the Dual-Image Output Style is selected.    The Background 
File contains the image that will be tiled (and distorted) to create the stereogram.    The distortion of 
the tiled image is how POPOUT-PRO hides the Source File drawing into the stereogram.
The Background File format may be either 256-color BMP, or Type 1, 2 or 3 Targa.    The Destination 
File will be of the same type as the Background File.

Note:
If the Background File is a non-mapped Type 2 Targa file, the Destination will also be of the same 
type.    This means that the resultant stereogram will be a 24-bit color print-quality image.



Output Style
The Output Style section of the POPOUT-PRO Main Menu consists of four "radio" style pushbuttons. 
The Output Style specifies the type of stereogram that you want POPOUT-PRO to create.    The 
following topics will discuss each of these Output Styles.
Black and White RDS Output Style
Random RDS Output Style
Custom Color RDS Output Style
Dual-Image Stereogram Output Style

Hint:
If you're experimenting just to see if you can get a viewable stereogram, and you're using Paintbrush 
to create your Source File, you may want to leave the Output Style set to Black & White, as these 
take up a lot less disk space than the other Output Styles.



Black and White Output Style
This is the default Output Style.    This Output Style selection will tell POPOUT-PRO to generate your 
Destination File RDS stereogram using only black and white colors.    If the Source File is a 16-color 
BMP, this output style will generate a 2-color BMP Destination File.    If the Source File is a Targa file,
the Destination File is stored as a Type 1 Targa.    For hardcopy to a simple black and white printer, 
this is the Output Style you'll want to use.



Random Output Style
This Output Style button tells POPOUT-PRO to generate the Destination file stereogram using a 
random selection of colors    POPOUT-PRO will choose from 16 bright colors for the image.
These stereograms are stored as a 256-color BMP file if the Source File is in BMP format, and as a 
Type 1 Targa if the Source File is Targa.

Hint:
POPOUT-PRO chooses from a random selection of relatively bright colors.    Since the choice of 
colors is random, there's no telling how the stereogram will look.    We've added a mecanism to 
"steer" POPOUT-PRO into choosing colors of a specified color.    You may note on the Main Menu 
that the Create Color Button is enabled when the Random Output Style is selected. If you click on 
the Create Color Button, then in the Create Color menu select one of the Background Colors, then 
press the Cancel button without saving anything, POPOUT-PRO will try to steer the random color 
generation toward that color you selected in the Background Color list.    It's still random, but the 
selected color will tend to appear more often than the other randomly selected colors.    For example, 
if you were making a stereogram with a St. Patrick's Day theme, you might want to use the Random 
Output Style.    By pressing Create Color, then selecting LtGreen from the Background list, then 
pressing Cancel, the resulting stereogram will tend to have more bright Green than the remaining 
colors.
Selecting Black as the Background color tells POPOUT-PRO not to bias the color selection, so that 
all colors have the same probability of being used.    Note that Black is the default Background color.

Another Hint:
The random number generator within POPOUT-PRO that is used for generating colors for this output
style is "seeded" when POPOUT-PRO is first started, and is never reinitialized as long as POPOUT-
PRO is running.    What this means is that if you don't like the color scheme of your stereogram, 
simply press Generate again and try a new set of random colors.    By using the Create Color 
Background color, you can usually get an acceptable color scheme within a few iterations of pressing
Generate.



Custom Color Output Style
This is the Output Style that allows users precise control over the coloring of their Random Dot 
Stereograms.    Stereograms of this type are stored by POPOUT-PRO in either BMP or TGA format, 
depending on the the Source File type.    When this Output Style is selected, POPOUT-PRO needs 
some mechanism to tell it precisely how to color the stereogram.    It uses something we call a Color 
File to do this.

Important!
Don't confuse the color of the stereogram with the colors in your Source File.    Those colors that you 
used in Paintbrush or that were generated by a ray tracing program were converted by POPOUT-
PRO to "levels", and have nothing to do with the color of the stereogram.
The Color File is the mechanism used by POPOUT-PRO to control the color of the stereogram.    The
Color File contains, in precise detail, how the color of the stereogram should vary from top to bottom 
of the image.
When using this Output Style, you must either create a new Color File by clicking on the Create 
Color button, or use a previously created Color File by clicking on the Color File button.
Selecting a Color File
Creating a Color File

Hint:
Color Files are independant of the stereograms.    You may eventually have an entire directory 
containg many Color Files that you've created.    Any Color File may be used to color any stereogram.
We suggest naming color files (which have a default extension of *.POC) such that they indicate the 
color scheme.    For example, a Color File containing the color scheme "LtRed, White, LtBlue" may 
be called something like USFLAG.POC, or RWB.POC.    Note that the Preferences menu allows your
to specify a default directory for your color files.



Selecting a Color File
The rectangular Color File button is used to select a previously created Color File when generating 
custom color stereograms.    Click on the button, then select the Color File you want POPOUT-PRO 
to use when coloring the stereogram (Color Files have a default extension of *.POC).
If you will be creating a new color scheme for the stereogram, you will need to create a new Color 
File.    In this case, click on the Create Color button.



Create Color
The Create Color button is used to access the Create Color Window.    This window is used to create 
a new color scheme, and hence, a new Color File.    Color Files are used in the creation of Custom 
Color stereograms.    The Background Color may also be used to statistically bias POPOUT-PRO in 
the selection of colors for the Random Output Style.
The Color File is a simple text file which describes to POPOUT-PRO how to color your stereogram.    
In a Custom Color stereogram, we consider some of the pixels to be foreground pixels, and others to
be background pixels.    The foreground pixels of the Custom Color stereogram may vary in color 
from top to bottom of the image.    The background pixels all have the same color value.
When you press the Create Color button, a window which we call the "Create Color File" window 
pops up.    In this window, you may select any number of colors from 1 to 50 to make up the color 
scheme of the foreground pixels in your stereogram.    You may also select the color of the 
background pixels.
For a detailed description of the "Create Color File" window, refer to the topic "Create Color File 
Window".    For a detailed description of the structure of a Color File, refer to the topic "Structure of 
the Color File".
Create Color File Window
Structure of a Color File



Create Color File Window
"Create Color File" is the name of a POPOUT-PRO window that is opened when you press the 
"Create Color" button.    The main purpose of the window is to allow the user to create a color 
scheme for Custom Color stereograms, and hence a Color File.    The window may also be used to 
bias POPOUT-PRO's selection of colors for Random Color RDS images.
The "Create Color File" window has the following controls:
Foreground Color Buttons
Background Color Select
Clear Button
Save and Cancel Buttons



Foreground Color Buttons
The "Create Color File" window contains sixteen buttons along the left side of the window.    These 
buttons are used to create a color scheme for the foreground pixels in Custom Color Stereograms.
You may press any combination of the sixteen color buttons from 1 to 50 times.    By the sequence 
and number of button presses, you will define how you want the color of foreground pixels to vary 
from the top to bottom of the stereogram.
For example, if you press the buttons LtRed-White-LtBlue, the foreground pixels of the stereogram 
will vary gradually from LtRed at the top of the image to White in the middle, then finally from White 
to LtBlue at the bottom.
As you press a color button, a list is maintained and displayed to remind you of the color scheme 
you're designing.

Hint:
Color buttons may be pressed more than once.    For example, the key presses LtRed-White-LtBlue 
will produce a color scheme different than pressing LtRed-LtRed-White-White-LtBlue-LtBlue.    
Experiment.

Another Hint:
If you've made a mistake, you can delete colors from the displayed list.    Click on the entry in the list 
to highlight it, then click on the Clear Button.



Background Color Select
To the right of the "Create Color File" window is a "combo box" which allows you to select the color of
the background pixels in a Custom Color stereogram.
The default color of these background pixels is Black.

Hint:
If you will be printing this stereogram, try using    White as the background color.    The resulting 
stereogram will tend to be less "busy" looking.

Another Hint:
When the Output Style is selected as Random RDS, POPOUT-PRO will randomly choose from the 
16 colors shown in the Create Color Window to make up the colors of your stereogram.    Murphy 
states that POPOUT-PRO will tend to choose colors you don't like!    It really is a random selection, 
and every time you press the Generate button, you'll get a new random color scheme.    We've added
a mechanism to try and "steer" POPOUT-RPO into emphasing a particular color when making its 
random selection.    For example, if you're creating an RDS with a St. Patrick's Day theme, you may 
want to generate a Random color RDS that is "heavy on the green".    In the Create Color Window, if 
you select the Background color as anything other than Black, POPOUT-PRO will try and give that 
selected color more priority over all others when making a random color selection.    The resulting 
stereogram will tend to have more pixels of that selected Background color contained in it.    You don't
have to save this to a color file, just choose the color from the list, and POPOUT-PRO will remember 
it.    If the Background color is Black, POPOUT-PRO will pick all colors with the same probability.



Clear Button
The Clear button in the "Create Color File" window has two purposes.    When selecting a foreground 
pixel color scheme, a list of the colors you've chosen appears in the center of the window.    If you 
click on one of the colors in the list to highlight it, then press the Clear button, the entry will be 
deleted from the list.    If you press the Clear button when no entries in the list are highlighted, all of 
the entries are deleted.



Save and Cancel Buttons
Once you've chosen a list of foreground colors, and selected a background color, click on the Save 
button to create a Color File.    You will be prompted for a filename for the Color File.    POPOUT-PRO
Color Files have a default extension of *.POC.
Once you've saved your color scheme into a Color File, the "Create Color File" window will close, 
and the name of your newly created Color File will be entered into the "Color File" space in the 
POPOUT-PRO Main Menu.
If you've decided that you don't want to be generating a Custom Color stereogram afterall, click on 
the Cancel button to close the "Create Color File" window.
If you've pressed the Create Color Button because you want to bias the random selection of colors 
for the Random RDS Output Style, you don't need to save anything.    Pressing Cancel will tell 
POPOUT-PRO to remember the Background color you selected, and this color will be the "preferred"
color when POPOUT-PRO creates your Random Color RDS.



Structure of a Color File
Most users will probably never have any need or desire to manually modify a Color File.    Since a 
Color File is a simple text file which can be edited using an editor such as Notepad, you may very 
well want to "tinker" with Color Files.
In the interest of simplicity, we designed the "Create Color File" window to create Color Files 
containing full and half intensity primary and secondary colors, as well as White and Black.    By 
"tweaking" a Color File, you can create color schemes including many other colors.    Therefore, 
we've included this topic to discuss the structure of a Color File.
As previously mentioned, a Color File is a simple text file.    The Color File can contain any number of
lines.    Each line contains a command to POPOUT-PRO.    There is a very strict syntax that must be 
adhered to in a Color File (remember, since Color Files are generated by POPOUT-PRO's "Create 
Color File" window, there's normally never a problem - problems only occur when you modify a Color 
File).
Each line in a Color File must begin with one of four words: RED, GREEN, BLUE, or BLACK (case 
does not matter).    Any number of lines may begin with the words RED, GREEN, or BLUE, but only 
one line may begin with the word BLACK.    Furthermore, the line beginning with the word BLACK 
must be the last line in the Color File.
For lines beginning with the words RED, GREEN, or BLUE, the syntax is as follows:
COLOR STARTC ENDC STARTY ENDY
where:
COLOR is either RED, GREEN, or BLUE
STARTC is the beginning intensity (in percent) of the color
ENDC is the ending intensity (in percent) of the color
STARTY is the beginning line (in percent) of the stereogram
ENDY is the ending line (in percent) of the stereogram
STARTC, ENDC, STARTY and ENDY are all integer numbers between 0 and 100 (inclusive), 
preceeded by one space.    ENDY must always be a larger number than STARTY.
For the line beginning with the word "BLACK", the syntax is:
BLACK REDC GREENC BLUEC
where:
REDC is the amount (in percent) of Red in the background pixels
GREENC is the amount (in percent) of Green in the background pixels
BLUEC is the amount (in percent) of Blue in the background pixels.
REDC, GREENC, and BLUEC must all be integer numbers between 0 and 100 (inclusive).
For example, the line:
 RED 0 100 0 100
would be interpreted by POPOUT-PRO to mean, "Gradually vary Red from 0% intensity to 100% 
intensity, from 0% down the image (the top) to 100% of the way down the image (the bottom).    In 
other words, this command will ramp any red in the image from full-off at the top of the stereogram, 
to full intensity at the bottom.
The following example is a Color File generated by pressing the sequence LtRed-White-LtBlue in the
"Create Color File" window, and selecting LtYellow as the background color.    Note that this 
sequence will cause the foreground pixels in the stereogram to be Red at the top of the image, 
gradually fading into White in the middle, then onto Blue at the bottom.    The background pixels will 
be Yellow.

RED 100 100 0 50
RED 100 0 50 100
GREEN 0 100 0 50
GREEN 100 0 50 100



BLUE 0 0 0 50
BLUE 0 100 50 100
BLACK 100 100 0
The above example Color File would be interpreted by POPOUT-PRO as follows:
The first line would be read by POPOUT-PRO as, "Vary Red from full-on at the top of the image, to 
full on in the middle of the image".    In other words, Red stays at full-on for the top half of the image.
The second line would be interpreted as, "Vary Red from full-on in the middle of the image to full-off 
at the bottom".
The third line tells POPOUT-PRO to vary Green from full-off at the top to full-on in the middle, and 
the fourth line says to ramp green from full-on in the middle to full-off at the bottom.
The fifth and sixth lines ramps Blue from full-off at the top to full-on in the middle, then to stay at full-
on for the bottom half.
When POPOUT-PRO combines all of this information when creating foreground pixels, we see that 
there is no Green or Blue at the top of the image, but lots of Red.    So, the very top of the image will 
be Red.    For the top half of the image, Green and Blue gradually increase in intensity so that in the 
middle, we have full intensity of all three colors, resulting in White in the middle (Red + Green + Blue 
= White).    Moving from the middle to the bottom of the image, both Red and Green fall to full-off, 
while Blue stays at full-on.    So, in the bottom half of the image, we fade from White to Blue.
The last line of the Color File redefines the Black, or background pixels, to be full-intensity Red and 
full-intensity Green, but no Blue.    Red + Green = Yellow, so the background pixels will be Yellow.

Hint:
If you're in there fiddling with Color Files, make sure and "overlap" both color and position values.    
For example, in the two lines above that describe Red, the middle of the image (50%) is defined in 
both lines.    Don't do something like:
RED 100 100 0 50
RED 100 0 51 100
In the above example, we haven't "covered" the area between 50% and 51% of the way down the 
image.



Dual Image Output Style
This output style does not generate a Random Dot Stereogram, but rather, a stereogram that hides 
one image into the slight distortions of a repeating series of a second image.    To generate this type 
of stereogram, you'll need two images.    The first is the Source File, which contains the depth 
information for the hidden image.    This is the same kind of Source File as in the other types of 
Output Styles.    The second image is called the Background Image.    The stereogram will be made 
up of a repeating series of this Background Image, and the Source File image will be hidden within it 
by distorting the series of background images.

The Destination File will be either in BMP or TGA format, depending on the Background File image 
type.

Note:
This particular Output Style is particularly sensitive to the Depth Factor,    Pixels/Inch, and 
Background width values.    If you see streaks in the image, try decreasing the Depth Factor, or use a
wider image as the Background Image.



Color File
The Color File button is used when you want POPOUT to create a stereogram with a color scheme 
that you have previously defined and stored on your disk as a Color File.    The Color File button is 
used to select the Color File.    This button is enabled only when you've selected the Output Style to 
be Custom Color.
Color Files are independant of stereograms.    You may in time have a directory full of miscellaneous 
Color Files.    Any Color File may be used to define the color for any Custom Color stereogram.
To create a Color File, refer to the topic "Create Color".
Create Color

Hint:
Color Files have a default extension of *.POC.    Name a Color Files to be descriptive of the color 
scheme it defines, not the stereogram you're using it to create.    For example, a Color File that 
describes the color scheme "LtCyan, LtMagenta, LtYellow, Black" might be named something like 
CMYK.POC.



Pattern Width
One of the first things you notice when looking at a Random Dot Stereogram is the seemingly 
repeating patterns of random dots across the width of the image.    We refer to this distance between 
repeating patterns as the Pattern Width.
When POPOUT-PRO generates a stereogram, it reads this parameter (which we've arbitrarily 
defaulted to 60) to determine how many pixels to generate before repeating the pattern.    The 
Pattern Width value is specified in Pixels.
Since we don't know the resolution or size of your monitor, and we don't know the resolution of your 
printer and whether you'll be scaling your image before printing it, we don't know the physical 
distance between patterns in your finished stereogram.    This physical distance between patterns is 
what increases or decreases the relative "depth" of the image contained within the stereogram.    The
wider the pattern, the more depth in the image.    Also, the wider the pattern, the more difficult it will 
be for some people to see the hidden image.
Depending on your own environment, you will probably want to experiment with different values for 
the Pattern Width.    We recommend a pattern width of somewhere between three quarters of an inch
to an inch and a half.

Note:
The Pattern Width value is not specified when the Output Style is selected as Dual-Image.    For this 
Output Style, the Pattern Width is defined as the width of the Background File image.    Be careful.    
There is a tendency to use background images that are too wide, making the stereogram very 
difficult to view.    Remember, the background image dictates the pattern width in this Output Style.    
Don't use background images that are any wider than you'd normally use as a pattern width.

Hint:
If you see more levels than you expected in your divergent stereograms, try increasing the Pattern 
Width.    If your image is too difficult to "lock in on", try decreasing the Pattern Width.



Pixel Density
When generating a Black & White or Custom Color stereogram, we have the concept of "foreground"
and "background" pixels.    In Black & White stereograms, we consider the White pixels to be in the 
foreground, and the Black ones to be in the background.    When creating Custom Color 
stereograms, we consider the colored pixels to be the foreground pixels, and the "Black" pixels 
(which may be redefined to another color) to be the background pixels.
The Pixel Density is a percentage value.    It specifies to POPOUT-PRO the percentage of foreground
pixels that should be generated.    The default value is 50, which tells POPOUT-PRO that when 
creating a Black & White or Custom Color stereogram, make roughly half of the pixels the foreground
color, and half of the background color.
The reason for including the Pixel Density parameter is for generating a stereogram which you intend
to print.    Users who copy their stereograms to directly to high density printers (such as the 300 and 
600 dots per inch with no scaling) will find that stereograms created with a 50% Pixel Density tend to 
be a bit dark.    By adjusting this value, a lighter print can be obtained.    Allowable values are from 1 
to 99 (both 0 and 100 make no sense, as this would produce an image of all foreground or all 
background pixels!)

Hint:
You can get some interesting RDS images by using very high or very low values for the Pixel 
Density.    It really is amazing how sparse your random dots can be, and the human brain is still able 
to discern the hidden image.    Try setting the Output Style to Black & White RDS, and set the Pixel 
Density to 90%.    Only 10% of the pixels in the resultant stereogram will be black pixels, but you'll 
probably still be able to see the hidden image!

Note:
The Pixel Density is not used when the Output Style is Random or Dual-Image, since there is no 
concept of foreground or background pixels.    In the Random Output Style, all pixel colors are 
chosen randomly by POPOUT-PRO.    In the Dual-Image Output Style, output pixels are generated 
by using pixels from the Background File image.



Depth Factor
The Depth Factor is a value used to give POPOUT-PRO a mechanism whereby you can trade off 
stereogram quality against the possible number of levels that will be generated.    This value is 
expressed as a percentage, and allows values between 1 and 100.    This number refers to the 
percentage of the original Pattern Width (or Background File width for Dual-Image stereograms) that 
will be sacrificed in order to maximize the number of levels that will be generated.    In other words, 
the higher the Depth Factor, the more depth will be generated, but at a cost of reduced quality.    The 
lower the Depth Factor, the lower the distortion in the image, but will result in less total depth.    This 
is particularly noticable in Dual-Image stereograms.
Whether or not your stereogram will be viewable is dependant on several factors, including the Depth
Factor, Pattern Width (or Background Image width), and Pixels/Inch parameters.    The goal is to 
make the Depth Factor as low as possible (thereby minimizing distortion) while getting as much 
depth as possible.
We've defaulted the Depth Factor to 50%, meaning that POPOUT-PRO will sacrifice up to 50% of the
Pattern Width when creating levels of depth in the stereogram.

Hint:
You may need to go through a few iterations of pressing the Generate button before you get a 
stereogram you're satisfied with.    If you see "streaks" in the image, or if the image is simply not 
viewable, try reducing the Depth Factor.    If the image is viewable but doesn't contain many levels, 
try increasing the Depth Factor.



Pixels per Inch
The Pixels per Inch parameter is used to taylor you output stereogram to your particular output 
media of interest.    The parameter is used by POPOUT-PRO to accurately develop the best quality 
stereogram.    If your intent is to view your stereogram on the CRT, your Pixels per Inch value would 
reflect the actual number of pixels per inch on your display.    If you intend to print your stereogram to 
a high resolution printer, you'll want to adjust this parameter to match the resolution at which you'll be
printing.
When creating stereograms with only a few levels, you'll probably never need to fiddle with this 
parameter.    We've included it for those cases when you'll be reading TGA format Source Files and 
generating stereograms with many levels.    In this case, telling POPOUT-PRO the resolution of the 
target image will aid in maintaining the constant distances between levels.
We've arbitrarily defaulted the parameter to 80 Pixels per Inch.



Generate and Exit
The Generate button in the POPOUT-PRO Main Menu is the "DO IT" button.    Once you've set up all
of the controls, click on the Generate button.
The first thing POPOUT-PRO will do is a bit of a sanity check on your choices for file names.    For 
BMP format images, we suggest using a file name extension of ".BMP", and for Targa images, we 
require an extension of ".TGA".    For the RDS Output Styles, POPOUT-PRO requires the extensions 
of the Source File and Destination File to be the same.    For Dual-Image stereograms, POPOUT-
PRO requires the extensions of the Source and Background files to be the same.
At this point, POPOUT-PRO will read your Source File drawing, and any appropriate controls that 
you've set Output Style, Pattern Width, etc.    POPOUT-PRO will then create a file on your disk with 
the name you gave as the Destination File.    This file is your stereogram.    POPOUT-PRO displays a 
status bar at the bottom of the menu to provide feedback as to where it is in generating your 
stereogram.    Depending on the speed of your computer, you may never even notice it.
Once POPOUT-PRO has finished generating your stereogram Destination File, you may exit 
POPOUT-PRO if you wish.    The "Exit" button is used to exit POPOUT-PRO.

Hint:
Don't exit POPOUT-PRO if you're experimenting with an image. Set the default viewer in the 
Preferences menu to either Paintbrush or some other viewer, depending on whether you're working 
with Targa or BMP files.

Another Hint:
Since the RDS is based on randomly generated pixels, sometimes you may get a stereogram that 
just doesn't "look right".    A glob of blue pixels here, a glob of black pixels there, etc.    Each time you 
press the Generate button, POPOUT-PRO uses a different set of random numbers, so keep hitting 
Generate, view the stereogram, go back and hit Generate again, etc., until you get a stereogram that
you like.    Note that this does not apply to the Dual-Image Output Style.    Since no random numbers 
are involved, the Destination image will be the same each time (assuming you haven't changed any 
other parameters).



Options
The Options pulldown menu has been included to provide a means for specifying various flags used 
by POPOUT-PRO in generating a stereogram image.    Each of these Option parameters are 
discussed in the topics listed below:
Diverging
Converging
Filter Enable
Maximize Quality
Maximize Depth
Maximize Levels
Guide Dots
Use Color



Diverging
This toggle is enabled by default.    It directs POPOUT-PRO to generate a "diverging" type of 
stereogram, the most common and easiest to see of stereogram images.    In this type of stereogram 
image, the viewer relaxes his eyes such that the point of focus is behind the image, and the hidden 
three-dimensional image appears behind the image plane.



Converging
This Toggle is used to direct POPOUT-PRO to direct the "convergence" type of stereogram image.    
This is a less common and harder to visualize image, where the viewer must "cross" the eyes such 
that the point of focus is in front of the image plane.    The hidden three-dimensional image will then 
appear in front of the image plane.

Note:
When this Toggle is selected, the "Maximize Depth" toggle will also be automatically selected.    This 
type of stereogram is very sensitive to the distance between the viewer and the image plane, and 
you'll want to maximize the amount of levels that can be generated.

Hint:
When generating this type of stereogram, you will want to use a Pattern Width a little larger that with 
the Divergence type.    Also, you will want to experiment with using larger values for the Depth Factor,
which tends to give better results.



Filter Enable
The Filter Enable and Filter Disable Options are used to enable and disable a simple low pass filter 
that is used on the Source File image.
The filter is used to try and "smooth out" abrupt changes in the Source FIle image when the image is 
of Targa type.    The filter is included because of the way ray tracing programs tend to stipple pixel 
intensities when there is a gradual change of depth.

Hint:
If, when using a Targa file generated by a ray tracing program is used as the Source File, and the 
resultant stereogram has "speckles" within it, enabling the filter will tend to reduce if not eliminate this
speckling.



Maximize Quality
This Option is selected by default when the Source image is of type Targa.    When this Option is 
selected, POPOUT-PRO will try to maintain a high linearity in the depth dimension.    In other words,   
POPOUT-PRO will try to maintain the same apparent depth between each level in the stereogram, at
the cost of the total numbers of levels.    This is especially important when generating the common 
Divergence stereogram images that has a significant amount of depth.    The effect of this option is 
not really noticable unless there is a significant amount of depth in the Source image, and the Depth 
Factor is set to a reasonable low value.    For 16-color BMP Source images, you'll get better results if 
you use the "Maximize Levels" Option.

Note:
When the Diverging Option is selected, this Option will automatically be selected.    The common 
Divergence type of stereograms are very sensitive to nonlinearities in the depth dimension, and you'll
find that if you don't tell POPOUT-PRO to maximize the quality, the image will be distorted.

Hint:
When generating the Convergence type of stereograms, the distance between levels is very 
sensitive to the distance between the viewer and the image plane.    Maximizing the quality is sort of 
a waste of depth in this case.



Maximize Depth
This Option has been included to allow POPOUT-PRO to sacrifice consistency in distances between 
levels for total depth of the image.    For the common Divergence type of images, you probably won't 
want to maximize the depth.    For the Convergence type, however, you probably will.    This Option 
will automatically be selected when you select the Converging Option.    This option factors in the 
Depth Factor, maximizing the amount of apparant depth while sacrificing a fraction of the Pattern 
Width as specified by the user via the Depth Factor.



Maximize Levels
This is the default setting when the Source Image is of type BMP.    With this option set, POPOUT-
PRO will ignore the Depth Factor value such that each change in the Source File intensity/color will 
put a corresponding change in the pattern of the stereogram.    For 16-color BMP Source Images, 
this is the recommended setting.    For Targa files with many levels (or widely spaced levels), this 
option will not give good results on a CRT.    It is intended for applications where the total difference 
between the maximum and minum intensities in the Source Image is a very small fraction of the 
Pattern Width.    For Targa Source Images that will be viewed on the CRT, we suggest either the 
Maximize Depth or Maximize Quality options.



Guide Dots
What we call "Guide Dots" are those annoying two blobs that you see at the top or bottom of a 
stereogram that some RDS generators produce.    While we don't personally like them, we realize 
that it helps some folks to see the image.    The Guide Dots are not generated by default.

Note:
Guide Dots are not generated for Dual-Image stereograms; they only apply to RDS images.    Since 
the pattern width is so obvious in Dual-Image stereograms (it's the background image), we saw no 
point in mudding up the image with anything else.



Use Color
These three colors are used when the Source File is a Type 1 or Type 2 full-color Targa file.    They 
tell POPOUT-PRO to get the depth value from either the Red, Green, or Blue component of the pixel.
Note that for Type 3 Targa files (greyscale), this toggle is not used.    Also, for 16-color BMP source 
files, the color-to-level mapping is predefined by POPOUT-PRO.



View and Print the Stereogram
Once you've clicked on the Generate button in the POPOUT-PRO Main Menu and POPOUT-PRO 
generated your stereogram, you will want to view it.    POPOUT-PRO saves your stereogram using 
the filename given as the Destination File, and saves it in either BMP or TGA format.    Black & White
stereograms are stored in either 2-color BMP format or Type 1 TGA format (depending on the Source
File type), while Random and Custom Color stereograms are stored as 256-color BMP or TGA files 
(also depending on the Source File type).    Dual-Image Destination Files are either 256-color BMP, 
or Type 1, 2 or 3 TGA, depending on the Background File type.
For Destination Files in BMP format, start Paintbrush, and Open the file that you specifed to 
POPOUT-PRO as the Destination File.    If you're not satisfied with something, either Open your 
Source File drawing and fix it, or fiddle with the parameters in POPOUT-PRO.    Once you're 
satisfied, you may want to print your stereogram.    Print your stereogram directly from Paintbrush.    
Refer to the topic "Hints for Printing".

For Destination Files in TGA format, you will need to use some other image viewer to print the image,
or else use some image converter to convert the image to a format that Paintbrush can read.
Hints for Printing

Hint:
When you're working on a stereogram, never exit POPOUT-PRO.    This makes any iteration of 
fiddling with your drawing, fiddling with POPOUT-PRO parameters, viewing the stereogram, fiddling 
again with your drawing, etc., a lot easier and quicker.



Hints for Printing
Paintbrush contains a nice mechanism for printing your stereograms.    There are a few tips, 
however, that we've included so that you produce the nicest looking hardcopy.
n Always use the Printer Resolution.    When you print using Paintbrush, there is a box in the 

Paintbrush Print window labelled "Use Printer Resolution".    Always 'X' this box.    If you don't, 
you may see vertical ridges or lines in your stereogram.

n Try to scale by integer multiples of 100.    In the Paintbrush Print window, scale by numbers like 
100%, 200%, 300%, etc.    Otherwise, you may see the same vertical lines or ridges mentioned 
above.

n Depending on the resolution of your printer, and the scaling factor mentioned above, you may 
need to go back and recreate your stereogram with a different value for the Pattern Width (or 
Background Image) in the POPOUT-PRO Main Menu.    On paper, the distance between 
repeating patterns should be around an inch to an inch and a half.

n If you've generated a Black & White stereogram, and your printing to a black and white printer, 
you may notice that the stereogram is a bit dark, especially if you have a high resolution printer 
and your print scale factor is small.    Go back and re-generate your stereogram with a higher 
value for the Pixel Density in the POPOUT-PRO Main Menu.

n We've had some good experience with taking a TGA format stereogram to the local quick-copy 
store.    For a small fee, these places (assuming they have the equipment) can read an image, 
and send it directly to a color copier.    The results are impressive, and by far the best quality for 
the buck.

For a High Resolution Printer (> 300 dpi)
If you intend to print your stereogram at a very high resolution, keep in mind that what you can print 
is far more resolute than what can be displayed on your CRT; perhaps by as much as a factor of 10 
or more.    This means that you may be able to produce an image which while unviewable on the 
CRT (because of a huge pattern width), is perfectly fine when printed.    Keep in mind that a most 
important factor in the quality of your stereogram is the linear pattern width; try to keep it between an 
inch and two inches.    On a 300 dot per inch printer, for example, you want a pattern width around 
300 or 400 pixels.    This image would be difficult to view (if not being totally non-viewable) on an 80 
pixel per inch CRT (making the linear width over 3 inches), but would look just fine on a printer, 
where the linear patter width would be about an inch.



Preferences
The Preferences menu is accessed by clicking on the "Configuration" pulldown in the POPOUT-PRO
main menu.    This menu allows you to specify your default image viewer, and the default pathnames 
of your images and color definition files.

Note:
When you click the "Save" button in the Preferences menu,    your default selections will be saved to 
disk, and will be used each time you start POPOUT-PRO.
Default Viewer
Default Directories



Default Viewer
The "Viewer" button in the Preferences window allows you to specify a default image viewer.    This is
the viewer that is used when you select the "View" pulldown in the POPOUT-PRO main menu.    By 
default, we've selected the Viewer program to be "PBRUSH.EXE", which is Paintbrush.    Note, that if
you work with Targa files, that Paintbrush cannot read Targa formatted images.    In this case, you 
would probably want to specify another viewer program.

Note:
The Default viewer must be located somewhere in your system PATH specified in your 
AUTOEXEC.BAT file.



Default Directories
The Default Directories specified in the POPOUT-PRO Preferences menu specify the default 
locations of your various POPOUT--related files.    This is handy if you choose to keep Source Files in
one directory, Destination Files in another directory, etc.

Note:
This Default Directory information is saved, and will be used each time you start POPOUT-PRO.



Hints for Viewing
Some folks will have no problems in viewing your stereogram images.    Others may need a bit of 
help.    Below is a list of "hints" that we've compiled from different people.
n Start with your head about a foot or so from the image.    Stare at it and let your eyes relax.    If 

things start to move out of focus, let them.    Keep staring.
n With your head about a foot from the image, suddenly move toward the image, and try not to 

refocus.
n Stare at something at a far wall.    Then, suddenly, glance at the image. Don't try to refocus on 

the image.
n Get your nose right up to the image.    Gradually (or for some people, quickly) move your head 

back.
n Practice by drawing two dots on a piece of paper about an inch or so apart.    Stare at them and 

let your eyes relax.    Both dots should go out of focus, and you will see a total of four fuzzy dots.  
Keep staring.    As the two middle fuzzy dots start to move toward each other, let them.    There 
will be a point where the two middle fuzzy dots meet, and you will see a total of three dots, where
the one in the center is clear, and the two edge dots are fuzzy.    This is what you need to be 
doing to your eyes to see the stereogram image.

n On a printed RDS, draw two dots like in the above hint just above the stereogram, at a distance 
identical to the pattern width.    Once you stare and see three dots, gradually move your eyes 
down into the stereogram without trying to refocus.    Some RDS generators do this automatically.
Personally, we think it's dumb.    You can always do this yourself with a pencil, or inside 
Paintbrush.    Of course, with a Dual-Image stereogram, you don't need this.

n Put your stereogram behind a piece of glass, then stare at your reflection in the glass.



Problems, Suggestions, etc.
If you've encountered some sort of problem in trying to generate a stereogram image using 
POPOUT-PRO, our first recommendation is to rummage through this Help file.    We've tried to 
include a number of tips and suggestions to give you the best possible results.    Chances are, the 
answer to your question is buried in this Help file somewhere.
If not, or if you have any other problems, either contact the agent or merchant that sold you your 
software.    If he or she can't answer your question, you can contact the authors by way of the 
addresses shown below:

POPOUT
C/O Bob Hankinson
P.O. Box 50632
Dallas, Texas 75250
Or via the Internet, America OnLine, or CompuServe:

Internet or AOL:    BHankinson@aol.com
CompuServe: 73144,1046



How to Register
To register this shareware copy of POPOUT-PRO, and receive a free copy of the non-shareware 
version, simply click on "Help" in the POPOUT-PRO main menu, then click on "Register".    A 
printable order form will be displayed.

Also, if you restart POPOUT-PRO, you can click on the "Order Form" button that will appear in the 
opening window.

The Order Form may be printed by clicking on the "File" pulldown in the Order Form window, then 
clicking on "Print Topic".



Allowable Image Formats
The following lists all of the image formats that POPOUT-PRO will accept.    We've selected these 
formats carefully, as accepting them makes for an easy interface to either Paintbrush or some of the 
popular ray tracing software packages available.

Source File Formats
POPOUT-PRO will accept any of the four following image formats as a Source File:
n 16 color BMP.    This image format is easily generated using Paintbrush.    It is intended to be the 

format of choice when creating a Source File by manually drawing a picture using the colors 
defined in POPOUT.PAL.    For users that create Source File drawings using Paintbrush, select 
"Options" in the Paintbrush window, then select "Get Colors".    Type in "POPOUT.PAL".    For 
folks using another drawing package, the refer to the topic "BMP Source File Colors" for a list of 
the colors recognized by POPOUT-PRO.    This topic lists the acceptable colors in the order of 
the level of depth that they will create in the output stereogram.

BMP Source File Colors
n Type 1 Targa.    This is a color mapped image.    POPOUT-PRO will accept up to 256 colors.    

Depth information is interpreted by POPOUT-PRO to be the intensity of the Red color.
n Type 2 Targa.    This is an unmapped color image.    POPOUT-PRO will interpret depth to be the 

intensity of the Red color,    just as in the Targa 1 format.    Note that this is not quite the manner 
in which ray tracers such as POLYRAY encode depth information.    Such an image must first be 
run through the PLY2POP utility, which will convert the image to a Type 3 Targa file described 
below.

n Type 3 Targa.    This is an unmapped grey-scale image.    POPOUT-PRO expects 8-bit pixels, 
and interprets depth as the intensity of the pixel.    Brightest pixels are closest to the viewer.    
This is the preferred format, as it makes for the shortest file with no doubt as to which pixels map
to which levels.    Most ray tracing programs encode depth into their output images in a manner 
different from this.    There is a DOS command-line utility on this disk called PLY2POP.EXE, 
which will convert a depth-encoded Type 2 Targa image to a Type 3 Targa for use as a POPOUT-
PRO Source File.    Read the file PLY2POP.TXT.

Note:
We have purposely NOT chosen some more common image formats as acceptable Source File 
formats.    Inevitably, we will receive mail that suggests, "Why don't you modify POPOUT to accept 
GIF format images, as I have plenty of GIF's that I'd like to create stereograms from."

As mentioned elsewhere, scanned images contain no depth information, and are therefore 
unacceptable as Source File images!    POPOUT (or any other stereogram generator) has no way of 
determining relative depth in the image.    Color and brightness are NOT the same as depth.

Destination File Formats
POPOUT-PRO will create stereograms in either 2-color BMP, 256-color BMP, or    Type 1, 2, or 3 
Targa formats, depending on Source File and Background File formats, as well as the Output Style 
selected.

The rules for Destination Files are as follows:

For RDS Output Styles, the Destination file must have the same extension (BMP or TGA) as the 
Source File.    For Dual-Image stereograms, the extension of the Destination File must be the same 
as the Background File.

Background File Formats
Background Files are only used for the Dual-Image Output Style.    Background files may be in 256-
color BMP, or Type 1, 2, or 3 Targa formats.



Warning!
Be careful when mixing file types.    There are instances when POPOUT-PRO is forced to create 
"upside down" stereograms!    While these are easy to fix using some graphics viewers, it is good to 
know.    This will occur when the Output Style is selected as Dual Image, the Source File is a "right-
side-up" Targa, and the Background is a 256-color BMP.    Since POPOUT-PRO creates a 
stereogram on a line by line basis, and because the Destination File must be BMP format (and 
BMP's are stored "upside down"), POPOUT-PRO is forced to write the image in an upside down 
fashion.    Both the hidden image and the tiled background pattern will be upside down, so "flipping" it
using some graphics viewer may be necessary.    This can be prevented by instructing the ray tracing
software that writes the Targa Source File to write it in an upside down fashion (Targa files can be 
stored either way).



BMP Source File Colors
When using a 16-color BMP format drawing as a POPOUT-PRO Source File, it is important to realize
that POPOUT-PRO expects certain colors to appear in the file.    If you're using Paintbrush to create 
the Source file, and you've redefined the Paintbrush palette with POPOUT.PAL, you probably won't 
have any trouble.    Refer to the topic "BMP Level Mapping" for a list of how POPOUT-PRO maps 
colors to levels for 16-color BMP Source Files.
BMP Level Mapping



BMP Level Mapping
When you save a 16-color BMP file to disk, the actual colors that are saved in the image are a 
function of your graphics driver, not a function of Windows.    This means that if your Source image is 
a 16-color BMP file, POPOUT-PRO must make some assumptions.    If you've designed your 16-
color BMP Source Image with Paintbrush, and you've used POPOUT.PAL to redefine your 
Paintbrush palette, you probably won't have any problems.    There is a slight chance, however, that 
POPOUT-PRO may not be able to differentiate between the Grey colors saved by Paintbrush.    We 
have found that if you've got Windows running in 64K or True-color mode, some graphics drivers will 
not save 16 unique colors from within Paintbrush.    With Windows running in 16 or 256-color modes, 
you shouldn't have any problems.    POPOUT-PRO assigns colors to levels of depth, and the 
following list shows how those colors are mapped by POPOUT-PRO to depth.    The first color in the 
list, Black, is interpreted by POPOUT-PRO to be the furthest level from the viewer.    The last color, 
White,    will be mapped to the level of depth closest to the viewer.
Black
Dark Red
Dark Green
Dark Yellow
Dark Blue
Dark Magenta
Dark Cyan
Dark Grey
Light Grey
Light Red
Light Green
Light Yellow
Light Blue
Light Magenta
Light Cyan
White



Definition of Terms
The following are descriptions of some of the terms that appear in this Help file.

Source File
The Source File is the primary input to POPOUT-PRO.    This is the file that contains the depth 
information that will be used by POPOUT-PRO to create the stereogram.    This file may be a 16-
color BMP file (which is easily created using Paintbrush), or may be a Type 1, 2 or 3 Targa file, which
can be created with some of the more popular ray tracing software available, in conjunction with the 
PLY2POP utility.

Destination File
The Destination File is the file that POPOUT creates.    This is the stereogram image.    POPOUT-
PRO will create either a 2-color or 256-BMP file, or a Type 1, 2 or 3 Targa file, depending on the type 
of the Source File, Background File, and/or Output Styles selected.    When generating a Black & 
White, Random Color or Custom Color RDS, the Destination File will be of the same type as the 
Source File.    When creating dual-image stereograms, the Destination File will be of the same type 
as the Background File.    Note that when creating dual-image stereograms, the Background (and 
Destination) File may be a Type 2 Targa, meaning that it is possible to create 24-bit true color 
stereogram images.

Background File
The Background File contains the image that POPOUT-PRO will use when creating a stereogram 
that contains a non-random repeating pattern or image.    Background Files are only used when the 
Output Style is selected as "Dual-image Stereogram".    Background Files may either be 256-color 
BMP files, or Type 1, 2 or 3 Targa files.    Background files are limited to a maximum size of 65536 
pixels (width x height).

Output Style
The Output Style refers to the type of stereogram that POPOUT-PRO will create.      POPOUT-PRO is
capable of creating four distinct types of stereogram images. Three of these output styles are 
Random Dot Stereograms.    We refer to these three output styles as Black & White, Random Color, 
and Custom Color.    Black & White RDS images are easy to generate and typically occupy less disk 
space.    They make nice images for hardcopy.    Random Color RDS images consist of 16 colors 
chosen randomly by POPOUT-PRO.        Custom Color RDS images use a color scheme created by 
the user and stored in something called a Color File.    Color Files are only used when creating 
Custom Color RDS images.    The fourth output style is called a Dual-Image Stereogram.    This kind 
of stereogram is not comprised of random dots (hence, it is not an RDS).    A different algorithm is 
used here.    The stereogram consists of a repeating series of images that has been distorted to 
contain the hidden image.    The Background File is used as the repeating image, and the hidden 
image is generated from the Source File.



UK Order Form

Oakley Data Services
3 Oakley Close, Sandbach,
Cheshire CW11 9RQ, England

Call +44 (0)270 759739
Fax +44 (0)270 765272
CIS: 100024,1763

Note:    You can print this Order Form by selecting the "File" pulldown above, then clicking on "Print 
Topic".

To:
Oakley Data Services, 3 Oakley Close, Sandbach,
Cheshire CW11 9RQ, England

Please send me _____ registered copy(s) of POPOUT-PRO, together with Shareware Versions of 
some of your other fine software.

Prices:

UK and EEC:
29.95 Pounds Sterling including P&P, plus VAT (17.5%) = 35.19 Pounds Sterling per copy.

Outside the EEC:
29.95 Pounds Sterling plus 2.00 Pounds Sterling P&P = 31.95 Pounds Sterling per copy.

Unless otherwise requested, we ship 3.5" HD disks.

Total Price: _____________

Inclose a cheque / wish to pay by MasterCard / Visa (delete as applicable)

Credit Card Details:

Name as on card: ________________________________________
Card Number:              ________________________________________
Expiry Date:                  ________________________________________

Please send the registered version of POPOUT-PRO to:

Name:          ________________________________________________
Address: ________________________________________________
                            ________________________________________________

Post Code: _________        Daytime Telephone: __________________



You can also contact us by:
Phone:                    +44 (0)270 759739
Fax:                            +44 (0)270 765272
Compuserve: 100024,1763

It would help in our distribution efforts if you tell us where you found your shareware copy of 
POPOUT-PRO.    Also, please include any ideas for future enhancements:
__________________________________________________________
__________________________________________________________
__________________________________________________________
__________________________________________________________



USA Order Form
Note:    This Order Form can be printed by clicking on the "File" pulldown above, then clicking on 
"Print Topic".
Please add my name to the list of registered users of POPOUT-PRO.    Upon receiving my 
registration, please send a complimentary copy of the non-shareware version of the software to:

Name:                        _______________________________________________
Street/Apt:            _______________________________________________
City/State/Zip: _______________________________________________

Unless otherwise noted, we ship 3.5" diskettes.
Registration Fee:                                                                                        $30.00
Sales Tax (TX Residents must add $2.25):        _________
Total:                                                                                                                  _________

Make checks payable to "POPOUT", and send your registration to:

POPOUT
P.O. Box 50632
Dallas, Texas 75250

Please note:
Orders to the above address from countries outside the United States must be paid for in US Dollars 
and checks must be drawn on a US Bank.    Otherwise, you must include an $8.00 collection fee.

If you have any questions, comments, or suggestions, the authors can be contacted via 
Compuserve, America OnLine, or the Internet.    Email is typically answered within a day.    Please 
use one of the following addresses:

Compuserve: 73144,1046
America OnLine: BHankinson
Internet: BHankinson@aol.com

Also, it would help in our distribution efforts if you could tell us where you received your shareware 
copy of POPOUT-PRO!    And thanks!
Bob Hankinson & Gary Peterson



Background color
The Background Color in the Create Color menu is used to specify the color of background pixels in the 
Custom Color Output Style, and is also used to bias the random selection of colors in the Random Color 
Output Style.



Background File
This is the file that contains the image that will be tiled and distorted to produce the Dual-Image type of 
stereogram.



background pixels
Pixels in a Custom Color stereogram that all have the same color



Black & White
A stereogram Output Style consisting only of black and white pixels



BMP
A standard image format.    Stands for "bitmap"



Cancel
Use this button to exit POPOUT.



Color File
Contains the color information for generating Custom Color stereograms



Create Color File
A window that pops up when the "Create Color" button is clicked



Create Color
Use this button to create a new color scheme.



Custom Color
A stereogram where the user designs the color scheme



Destination File
This is the file that POPOUT creates that contains your stereogram.



Dual-Image
This is a type of stereogram generated by tiling a background image, and distorting the tiled image in 
such a way as to hide another image within it.



EXAMPI.BMP
A sample Source File drawing included with this diskette.



foreground pixels
The white pixels in Black & White stereograms, and the colors that are varied in Custom Color 
stereograms.



Generate
Use this button to create the stereogram.



GIF
You've probably got some images stored in GIF format.    POPOUT doesn't support this format just so 
you won't try creating stereograms of your scanned image.    It won't work.    Trust us.



Output Style
Specifies the type of stereogram that POPOUT will generate



Paintbrush
Paintbrush is a drawing tool included with Microsoft Windows.    POPOUT was designed specifically to 
be used with Paintbrush.



palette
At the bottom of the Paintbrush window is the palette of colors you use in drawing.    With POPOUT, only 
use the left-most 16 colors.



Pattern Width
The distance in pixels between repeating patterns in the stereogram



Pixel Density
For Black & White and Custom Color stereograms, the percentage of pixels that are foreground pixels.



POC
Default Color File extension



POP16ORG.POT
A Translate File included with this diskette



POPOUT
POPOUT is a Windows based Random Dot Stereogram generator.



POPOUT.PAL
This is a Paintbrush palette definition file that blackens all but the left-most 16 colors in the Paintbrush 
palette.



POPOUT.POT
A Translate File included with this diskette



POPOUT16.POT
A Translate File included with this diskette



Random
A stereogram Output Style consisting of randomly chosen colors



RDS
Random Dot Stereogram



scan
Scanned photographs are not suitable for stereograms as they contain no depth information.



seed
The random number generator used for the Random Color Output Style is seeded, or initialized, when 
POPOUT is first started, then is not touched as long as POPOUT is running.



Source File
This is the drawing your create which will be "hidden" within the stereogram.



Stereogram



Targa
The Targa format is the "format of choice" of popular ray tracing software.    POPOUT supports Type 1, 2 
and 3 Targa formats.



TGA
Targa format



Translate File
A text file that provides the "final word" on how POPOUT will convert colors to levels.






